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ABSTRACT 

In the present era, demand of food is increasing due to increasement of population of 

people in the world. However, our supply of foods does not meet the demand of food for 

the people all the around the world. For example, Africa is currently facing the food crisis 

since 1945. Collision of climate change and population growth has created massive food 

shortages in Africa, and this would cause millions of dies in coming months. Plant is the 

main source of food providing us with fruits and vegetables, which are an important source 

of fibres, proteins, and carbohydrates. But the ways of plantation in our world still not 

optimise to a high production to produce enough demand for the market. Therefore, to 

overcome this problem, an automated irrigation system is vital in current situation. 

Automated irrigation system not only can reduce the amount of manpower but also make 

the plantation to be more systematic and easier to manage. Just at your fingertips, the 

irrigation can be control and monitor though the smart device. The aim of this solar 

irrigation system is to provide a technology of automated irrigation system to the farmer 

or industry. This technology could be operated in anywhere even there is no supply of 

electricity as long as there is existing of sunlight. Besides, this system is completed with 

sensors which could immediately give a notification to the user through application. The 

objective of our project is mainly about designing of IoT-based solar irrigation system. 

Therefore, in this thesis, the whole system is developed with assistant of solar power. The 

system includes the microcontrollers, sensors, solenoid valve and LCD. The present of 

microcomputer is to control the water flow and give information to the user through device 

on irrigation system. Solenoid valve is the component which control by the microcomputer 

meanwhile the sensor is to collect the information of real situation environment. In result, 

we success to develop a system which able to irrigate the crops or plants using solenoid 

valve controlled by smartphone with monitoring features. These monitoring features are 

able to view either in mobile application or browser in any devices and controlling function 

of valve is able to use through the mobile application. This system is completed with water 

management features which the information of water pressure, flow rate and total amount 

of water display on the LCD. 
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ABSTRAK 

Pada era sekarang, permintaan makanan semakin meningkat akibat peningkatan jumlah 

penduduk di dunia. Walau bagaimanapun, bekalan makanan kami tidak memenuhi 

permintaan makanan untuk orang di seluruh dunia. Contohnya, Afrika kini menghadapi 

krisis makanan sejak tahun 1945. Pertembungan perubahan iklim dan pertumbuhan 

penduduk telah menyebabkan kekurangan makanan di Afrika dan ini akan menyebabkan 

berjuta-juta kematian dalam beberapa bulan mendatang. Tumbuhan adalah sumber utama 

makanan yang membekalkan kita buah-buahan dan sayur-sayuran, yang merupakan 

sumber penting serat, protein, dan karbohidrat. Tetapi cara penanaman kini masih tidak 

dapat dioptimumkan dengan pengeluaran yang tinggi untuk memenuhi pasaran. Oleh itu, 

untuk mengatasi masalah ini, sistem pengairan automatik sangat penting dalam keadaan 

semasa. Sistem pengairan automatik bukan sahaja dapat mengurangkan jumlah tenaga 

kerja malah juga menjadikan penanaman menjadi lebih sistematik dan mudah diurus. 

Hanya di hujung jari, pengairan boleh dikawal dan dipantau melalui alat pintar. Tujuan 

sistem pengairan suria ini adalah untuk menyediakan teknologi sistem pengairan automatik 

kepada petani atau industri. Teknologi ini dapat dikendalikan di mana saja walaupun tiada 

bekalan elektrik selagi ada cahaya matahari. Selain itu, ia dilengkapi dengan pengesan 

yang dapat segera memberi notis kepada pengguna melalui aplikasi. Objektif projek kami 

adalah terutamanya mengenai merancang sistem pengairan suria berasaskan internet benda 

(Internet of things, IoT). Oleh itu, dalam tesis ini, keseluruhan sistem dibangunkan dengan 

pembantu tenaga suria. Sistem ini merangkumi mikrokontroler, pengesan, injap solenoid 

dan paparan hablur cecair (liquid crystal display, LCD). Kehadiran komputer mikro adalah 

untuk mengawal aliran air dan memberi maklumat kepada pengguna melalui peranti pada 

sistem pengairan. Injap solenoid adalah komponen yang dikendalikan oleh komputer 

mikro sementara itu pengesan untuk mengumpulkan maklumat persekitaran situasi sebenar. 

Hasilnya, kami berjaya menghasilkan sistem yang dapat mengairi tanaman menggunakan 

injap solenoid yang dikendalikan oleh telefon pintar dengan ciri pemantauan. Ciri 

pemantauan ini dapat dipapar dalam aplikasi mudah alih atau penyemak imbas di mana-

mana peranti dan fungsi pengendalian injap dapat digunakan melalui aplikasi mudah alih. 

Sistem ini dilengkapi dengan ciri pengurusan air yang mana maklumat mengenai tekanan 

air, laju aliran dan jumlah paparan air pada LCD.melalui aplikasi mudah alih. Sistem ini 
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dilengkapi dengan ciri pengurusan air yang mana maklumat mengenai tekanan air, kadar 

aliran dan jumlah air yang dipamerkan pada LCD. 
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CHAPTER 1 

INTRODUCTION 

 

1.1 Background of study 

Nowadays, there are many technologies that have been developed to be used by us 

in our daily life. With this development of technology, people had created amazing tools 

that can be use in various way and it make the work become easier. All the access to 

industry, medicine, transportation, agriculture, and many more has been simplified due 

to the current technology. 

Now with the advancement of technology, the system use in agriculture has 

transform from traditional method to modern machinery or automation system. There has 

been a development in plant operation in agriculture section, which require a high 

accuracy in processes to optimize output and also the quality of the product or crops. 

Furthermore, it is also a need to reduce the running cost of the plantation. To achieve the 

required, we need to have automation system. 

With this project, we try to make and automated irrigation system. This system will 

help to solve the problems of irrigation in plantation such as the consumption of large 

quantities of water. So that, the error will not affect the crops that has been plant. It also 

can help in reducing the production cost for the farmers. The system will be controlled 

automatically, so it will reduce manpower needed and reduce the management cost for 

plantation. 

The importance of irrigation is to encourage the proper growth of plants and to 

maintain the correct level of soil moisture. Besides, it is also ensuring that contingency 

protection is provided when there is a short period of drought, as this can support the field 

enough when water levels are low. Irrigation is to cool the atmosphere and soil which is 

an ideal environment for plants. With irrigation, the risk of soil piping can be reduced, 

which can increase subsurface erosion due to the abnormal underwater flow. Soil piping 

is an alternative method of irrigation, but they can endanger the agricultural output as 

well as the stability of any surrounding building with movement when soil moisture levels 

are too high and cause the building to change (MDM Landscape, 2019). 
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Water, an important resource for crop production, is an increasingly scarce 

commodity, as the region dedicated to crops continues to expand due to a progressive rise 

in the world's population. Globally, 11 per cent of the land is planned for agricultural use 

and is responsible for 70 per cent of water withdrawals. Water intended for agricultural 

use shall be collected from rivers, streams, wells, sewage treatment plants and seawater 

desalination systems, as well as from water reservoirs or rafts in areas where there is no 

continuous flow (SINTECPROOF, 2019). 

This project also will have a collaboration with Yayasan Pahang Plantation Holding 

Sdn Bhd (YPPH). YPPH was establish in 1985 as a subsidiary of Yayasan Pahang. 

Formerly YPPH was known as Sumber Perindu Sdn Bhd. On 24 January 2003, the name 

Sumber Perindu Sdn Bhd was changed to YP Plantation Holding Sdn Bhd (YPPH) where 

the selection of this new name was on recommendation of YAB Menteri Besar of Pahang, 

Dato’ Sri DiRaja Haji Adnan bin Haji Yaakob, as the chairman of the company. 

 

 

Figure 1. 1 YPPH Structure 

 

YPPH had started the operation of palm oil plantation in 1994 at Pulau Manis, 

Pekan, Pahang with an area covered of 1,171 acres. In 1996 YPPH increase their 

plantation area with 10,000 acres in Endau-Rompin and had opened up about 32,000 

acres in Rompin in 2002. Then in 2004 they take over Ladang Gambang, Kuantan with 

an area covered 12,000 acres. YPPH continue to expand their plantation area by opening 

a new nursery at Pekan in 2009 with an area 27,000 acres. Now they are developing 

10,000 acres of new farm located at Pekan, Pahang. 
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Table 1.1 YPPH Farm Area 

FARM AREA (ACRES) 

Kuantan 7,149 

Rompin 21,080 

Pekan 21,995 

(In Development) Pekan 30,021 

Total Area 80,205 

 

YPPH also have a nursery plant in Bukit Payong with an area 80 hectare. The 

capacity for this nursery is 1 million seeding and have water source from the lake nearby. 

The objective of this nursery is to prepare a high-quality seedling for replanting program 

at Ladang Tanjung Gemok (LTG) and Ladang Endau Rompin (LER). This is where we 

are planning to use the automated irrigation system to get the quality output with efficient 

monitoring. 
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1.2 Problem statements 

Agriculture is one of important sector of economy in Malaysia, such as rubber and 

palm oil. Therefore, it is very important to have a good quality of the crops. The 

traditional way of plantation is usually using sprinkler to irrigate the crops or plants. This 

way of irrigation requires high water pressure. Therefore, diesel fuel water pump will be 

used to provide high pressure of water. 

Using diesel fuel may create many harmful emissions when it is burned and this 

phenomenon lead to air pollution, such as ground-level ozone and particulate matter (U.S. 

Energy Information Administration, 2020). Meanwhile, if this diesel fuel water pump is 

replaced with an electric water pump that powered directly by main electricity will also 

cause air pollution as the main electricity is produced through nonrenewable resource. 

Although most of the time the main electricity is produced by renewable resources, but 

when the peak period of using electricity, boost electricity is supply through combustion 

of nonrenewable resources. 

Hence, farmers have to focus on some important matter such as the appropriate 

amount of water supply for irrigation of crops, as well as the usage of electricity for the 

irrigation system. Furthermore, farmers also want to cut the cost of production by 

reducing manpower. Manual way of irrigation requires manpower and this lead to the 

increasement of cost. Different type of irrigation system has different consumption of 

water. A suitable irrigation system may reduce the amount of water usage. This project 

will be an automated irrigation system controlled using mobile application. With this 

system, farmers can reduce the manpower in plantation, control the irrigation wirelessly, 

save water and electricity, and monitor the surrounding conditions of crops or plants. 

 

1.3 Objectives 

This project has objectives as below: 

1. To design a system that can optimize water management using IoT. 

2. To produce semi-automated irrigation system. 

3. To optimize the system with monitoring features. 
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1.4 Scope 

The aim of this project is to design a system which is affordable by the farmer and 

it may help to reduce the cost on the manpower. The objectives that listed give us an 

insight to develop an IoT-based solar irrigation system with monitoring features. This 

innovation is used the developed solar water pump to attach into the irrigation system. 

Hence, the solar water pump not only portable use to irrigate the plant but also be a 

controlling system to this project. 

The solar water pump was developed by previous SDP students. The water pump 

powered by solar is portable and it has 2 sensors which are soil moisture sensor and 

temperature & humidity sensor. This water pump can be controlled and monitor using 

mobile application. This solar water pump will make the irrigation process easier to 

control and monitor. But in our project, we improve this solar water pump to be used to 

control the solenoid valve. Water pump had been replaced with solenoid valve as we do 

not need high water pressure to irrigate the plants as we use the drip system that using 

low pressure of water. And this problem we had solve by using the tank that placed above 

ground with 3 metres that will produce gravity force and provide low water pressure.  

Furthermore, we improve the monitor features with raindrop sensor which able to 

detect overflow water to the plants. Besides, a water flow sensor and pressure gauge are 

placed before the solenoid valve which provide water flow monitoring system. The 

previous project is only can be monitored in mobile application and we upgrade this 

feature to be displayed in web through browser. It can be displayed in any device as long 

as it has internet. 

This IoT-based solar irrigation system can be used at any plantation or nursery. The 

main component needed for this system consist of Arduino Uno, NodeMCU, Raspberry 

Pi, solenoid valve and sensors. Lastly, the scope for this project is to create a 

programming code for NodeMCU ESP8266 and Arduino Uno microcontroller to enhance 

the system as it provides remote function towards the user. 
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1.5 Organization of thesis 

In this paper there will be 5 chapters including introduction, literature review, 

methodology, result and discussion, and conclusion. Introduction would briefly explain 

the project in general such as the project background, project statement, objectives and 

also the scope of the project. For Chapter 2, it contains all the past research from related 

field researcher which give an idea and reference for this project. These past research act 

as guidance and improvisation that combining the benefit of few past project can be seen 

in this project. In Chapter 3, the information of design, electrical part, and component 

sizing. Result and discussion contain of the changes and process of uncompleted project 

until the finished project which contain the finding of the project process. Finally, Chapter 

5 is the part of summarize all the important feature of this project and the suitable 

recommendation that can be modify in future. 
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CHAPTER 2 

LITERATURE REVIEW 

 

2.1 Introduction 

In this chapter, will discuss about the irrigation system concepts, the details of 

irrigation system and the type of system use in irrigation system. Related works from 

different country will be discussed below. 

 

2.2 Concept of irrigation 

Irrigation defines as a process of supplying water to the crops or plants artificially 

to fulfil their water requirements. Nutrients may also be supplied to the crops through 

irrigation. There are many sources of water for irrigation such as wells, canals, ponds, 

lakes, tube-wells and dams. Irrigation offering moisture that needed for growth, 

development, or germination of the plants. The type of irrigation also divides into many 

ways such as surface irrigation, localized irrigation, sprinkler irrigation, drip irrigation, 

centre pivot irrigation, sub irrigation, and manual irrigation. The time taken, frequency, 

rate, water amount of irrigation is different according to the types of irrigation, soil, and 

seasons. For example, summer crops require a higher amount of water as compared to 

winter crops (BYJUS, 2020). 

 

2.3 Comparison of manual and automatic irrigation systems 

In Switzerland, the major part of the 500 ha strawberry production area is cultivated 

with drip irrigation. Traditionally, the irrigation management is based on the monitoring 

of the soil moisture combined with a manually operated irrigation system, which is quite 

time consuming. In Switzerland, salaries are high and are a major production cost. The 

use of fully automatic irrigation systems might help to reduce production costs and 

eventually reduce the amount of water used for irrigation. From 2013 to 2015, a field 

experiment was carried out to compare two manual irrigation systems (traditional 

producer manual approach and optimised) and two automatic irrigation system 

(Watermark and PlantCare) on yield and fruit quality (fruit size, acidity, sugar, firmness) 
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of strawberries. During the irrigation period, the average daily water volume was 1.1 - 

1.2 L m-2 for the optimised irrigation systems (manual or automatic) and 1.6 L m-2 for 

the traditional manual producer irrigation system. This important reduction of the 

irrigation water volume had no impact on yield and fruit quality. The optimised manual 

irrigation system could save as much water as the automatic irrigation systems but 

increased the workload (A. Ançay, V. Michel and C.A. Baroffio, 2017). 

 

Manual producer system 

The irrigation system was based on the reading of three tensiometers twice a week. 

When the median of three tensiometer values reached the threshold value, irrigation was 

activated manually to dispense a predefined water volume. 

 

Manual optimised system 

The irrigation system was also based on tensiometer measurements, which occurred 

at a higher frequency than in the Manual producer system. When the threshold was 

reached (median of three tensiometers), the irrigation was manually started to dispense a 

predefined water volume, which was different from the Manual producer system. 

 

Automatic Watermark (WEM) system 

The automatic WEM system was based on measurements taken from three 

Watermark sensors connected to an electronic control module. The sensors measured the 

soil moisture four times per day (9 am, 11 am, 1 pm, 3 pm). When the threshold value of 

20 kPa was reached at one of the four measuring moments, irrigation started 

automatically to dispense 0.75 L m-2. 
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Figure 2.1 Soil moisture of the manual producer system (median of 3 Watermark 

sensors for each depth). Each arrow indicates an irrigation cycle. 

In the manual producer system, a continuous change of soil moisture between 0 and 

20 kPa, was measured at a depth of 25 and 35 cm (Figure 2.1), which indicates an 

excessive volume of water applied for irrigation. 

 

Figure 2.2 Soil moisture of the manual optimised system (median of 3 Watermark 

sensors for each depth). Each arrow indicates an irrigation cycle. 
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In the manual optimised system, a similar soil moisture pattern was measured until 

mid-May (Figure 2.2). Starting from this moment, the soil moisture level at 25 cm depth 

did no more climb higher than 15 kPa, this was caused by the rising temperatures. This 

effect was even stronger at a depth of 35 cm. There was no visible loss of water, the water 

was consumed in the top 25 cm soil layer. The WEM system showed a continuous change 

in soil moisture at 25 cm depth, where it varied between 0 and 15-20 kPa. At 35 cm depth, 

in contrast, the soil moisture decreases from the beginning of the irrigation period. This 

could be the result of the higher irrigation frequency (max. 4 times per day), but a quite 

lower water volume per irrigation. 

 

 

Figure 2.3 Soil moisture of the WEM system (median of 3 Watermark sensors for each 

depth). Each arrow indicates an irrigation cycle. 

 

The investigation carried out on different irrigation systems in strawberries 

showed that with higher workload in a manual or with an automatic irrigation system, an 

important volume of irrigation water can be saved. The automatic systems have a 

potential to reduce labour and water at the same time. There were no statistically 

significant differences in yield, fruit size and fruit quality of the different irrigation 

systems. 
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2.4 Smart Irrigation System using Arduino 

Water plays an important part in a human’s daily life. In India for example many 

agricultural land and industries already are facing the problems of drought, so this issue 

can be solved with the help of current technology. Today’s technology requires an easy-

to-use device which is economical and effective such as Arduino. The system has two 

different part. For the first part is setting up an Arduino and interface it with a few sensors. 

For the second part is the integration with the IoT platform which is using ESP 8266 Wi-

Fi moduled. It is used for transmission to becomes simpler and faster. It will help the 

farmers to monitor the system easily. (S. Thakare, P. H. Bhagat 2018) 

 

2.5 Microcontroller Based Automatic Plant Irrigation System 

In this system the sensor of soil moisture is placed in the plant. The sensor will send 

an information to the microcontroller and passes the data on. An algorithm was developed 

for measuring the threshold value of the soil moisture sensor, which was programmed 

into a microcontroller to monitor the soil moisture content. This system is based on 

microcontroller ATMEGA328. Farmer will get the information through GSM module 

without going to the nursery. (BD Kumar, P Srivastava, R Agrawal, 2017) 

 

2.6 Precision Water Saving Irrigation Automatic System 

There are some studies show that moisture and temperature are two main 

environmental factors for plants growing. The impact on different soil water handling on 

stem weight, and root weight, total biomass is notable, plant leaves relative moisture 

content and water consumption volume per plant decrease with the reduction of soil water. 

When soil water content is higher than a certain value, the plants could survive. However, 

when soil water content is too high, it will not only cause the root to decay, but also a 

waste of water at the same time, and as a result of too much irrigation, water infiltration 

will take away large fertilizer, which causes a waste of fertilizer, pollution of groundwater 

resources. Therefore, controlling soil water content near root of plants in a certain range 

between plant survival threshold value and plant water requirement with the largest 

biomass could ensure a large number of waters saving and plant's appreciation. (Y. Zhao, 

J. Zhang, J. Guan and W. Yin, 2009) 
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2.7 Control and Automation in Citrus Microirrigation  

Microirrigation (drip and microsprinklers) is the predominant method of irrigation 

for citrus in Florida. With chemigation, microirrigation systems it can also provide an 

economical method of applying fertilizer and other agricultural chemicals on a time basis. 

Microirrigation systems require a high level of management expertise compare to other 

irrigation methods. Microirrigation systems are more complex, which it requires greater 

filtration and water treatment, and have high maintenance costs compared to other types 

of irrigation. Irrigations generally must be scheduled more frequently with 

microirrigation systems, since they reach only a fraction of the root zone as compared to 

other types of systems (Brian Boman, Steve Smith, and Bill Tullos, 2006). 

There is a way to manage the higher demands of microirrigation is by using of 

automation and central control systems. With these technologies, it allows efficient 

control of water flows to various zones; injection of water conditioners, fertilizers, and 

agricultural chemicals; allow remote checks of system performance; control filter 

backflushing; and provide extensive records of water use. More sophisticated systems 

allow irrigations to be scheduled based on evapotranspiration (ET) calculations from 

nearby weather stations. In many citrus microirrigation systems, a controller is an 

important and integral part of the irrigation system. 

Controllers can help to achieve labour savings in addition to applying water in the 

necessary quantity and at the right time to achieve high efficiency in water, energy, and 

chemical uses. Irrigation controllers have been available for many years in the form of 

mechanical and electromechanical irrigation timers. These devices have evolved into 

complex computer-based systems that allow accurate control of water, energy and 

chemicals while responding to environmental changes and crop demands. 

There are two control strategies in this project, which is by using two general types 

of controllers to control irrigation systems: open control loop systems and closed control 

loop systems. Open control loop systems apply a preset action, such as is done with 

simple irrigation timers. Closed control loops receive feedback from sensors, make 

decisions and apply the results of these decisions to the irrigation system. 
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2.7.1 Open Loop System 

In an open loop system, the operator makes the decision on the amount of 

water to be applied and timing of the irrigation event. The controller is programmed 

correspondingly, and water is applied according to the desired schedule. Open loop 

control systems use either irrigation duration or a specified applied volume for 

control purposes. Open loop controllers normally come with a clock that is used to 

start irrigation. Termination of the irrigation can be based on a pre-set time or may 

be based on a specified volume of water passing through a flow meter. 

 

2.7.2 Closed Loop System 

In closed loop systems, the operator develops a general control strategy. Once 

the general strategy is defined, the control system takes over and makes detailed 

decisions on when to apply water and how much water to apply. This type of system 

requires feedback from one or more sensors. Irrigation decisions are made, and 

actions are carried out based on data from sensors. In this type of system, the 

feedback and control of the system are done continuously. Closed loop controllers 

require data acquisition of environmental parameters (such as soil moisture, 

temperature, radiation, wind-speed, etc) as well as system parameters (pressure, 

flow, etc.). Figure below show that a simple version of a closed loop control system 

is that of an irrigation controller. A moisture sensor interrupts the irrigation process. 

When soil-moisture drops below a certain threshold, the sensing device closes the 

circuit, allowing the controller to power the electrical valve and the irrigation starts. 

 

Figure 2.4 Simple version of a closed loop control system. 
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2.7.3 Controllers 

In the simplest form, irrigation controllers are devices which combine an 

electronic calendar and clock and are housed in suitable enclosure for protection 

from the elements. The controller provides a low-voltage output (typically 12 or 24 

volts DC or 24 volts AC) to the valves and control devices for specific zones. As 

long as the voltage is applied, valves stay open and irrigation water is applied. Most 

remote-control valves are “normally closed” meaning that the valve is closed until 

the solenoid is actuated by the controller. A “normally open” control valve remains 

open until such time as the solenoid is actuated. Normally open valves are 

sometimes used as master valves in systems when it is desirable to have a 

continuously pressurized mainline but still have a primary valve that can be closed 

in the event of excessive flow or other alarm conditions. 

 

2.7.4 Sensors 

A sensor is a device placed in the system that produces an electrical signal 

directly related to the parameter that is to be measured. In general, there are two 

types of sensors: continuous and discrete. Continuous sensors produce a continuous 

electrical signal, such as a voltage, current, conductivity, capacitance, or any other 

measurable electrical property. Continuous sensors are used when just knowing the 

on/off state of a sensor is not sufficient. For example, to measure pressure drop 

across a filter (Figure 2.5) or determine tension in the soil with a tensiometer fitted 

with a pressure transducer (Figure 2.6) requires continuous-type sensors. 
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Figure 2.5 Control panel for automatically backflushing filters based on pressure 

differential between inlet and outlet of filter. 

 

 

Figure 2.6 Tensiometer fitted with pressure transducer to provide continuous feedback 

of soil tension status. 
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2.8 Real-Time Automation and Monitoring System for Modernized Agriculture 

The technological development in Wireless Sensor Networks made it possible to use in 

monitoring and control of greenhouse parameter in precision agriculture. Due to uneven natural 

distribution of rain water it is very crucial for farmers to monitor and control the equal distribution 

of water to all crops in the whole farm or as per the requirement of the crop. All the parameters 

of greenhouse require a detailed analysis in order to choose the correct method. With the evolution 

in wireless sensor technologies and miniaturized sensor devices, it is possible to use them for 

automatic environment monitoring and controlling the parameters of greenhouse, for Precision 

Agriculture (PA) application. In the Field bus concept, the data transfer is mainly controlled by a 

suitable wired communication system, now can be replaced with the hybrid system (wired and 

wireless) to extract the benefits of both and to automate the system performance and throughput. 

ZigBee protocols based on IEEE 802.15.4 – 2003 for wireless system are used. The atmospheric 

conditions are monitored and controlled online by using Ethernet IEEE 802.3. Partial Root Zone 

Drying Process can be implemented to save water at the maximum extent. Online interaction can 

be made with the farmers by the consultant to give them the knowledge about this technique and 

implement it effectively in their farms to extract more yield with advanced technology (V.Vidya 

Devi and G.Meena Kumari, 2013). 

2.9 IoT Based Smart Irrigation System 

Automation of farm activities can transform agricultural domain from being manual 

and static to intelligent and dynamic leading to higher production with lesser human 

supervision.  This paper proposes an automated irrigation system which monitors and 

maintains the desired soil moisture content via automatic watering.  Microcontroller 

ATMEGA328P on arduino uno platform is used to implement the control unit. The setup 

uses soil moisture sensors which measure the exact moisture level in soil. This value 

enables the system to use appropriate quantity of water which avoids over/under 

irrigation. IOT is used to keep the farmers updated about the status of sprinklers. 

Information from the sensors is regularly updated on a webpage using GSM-GPRS 

SIM900A modem through which a farmer can check whether the water sprinklers are 

ON/OFF at any given time.  Also, the sensor readings are transmitted to a Thing speak 

channel to generate graphs for analysis (S. Raval, 2017). 
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2.10 Summary 

Irrigation can be categorized into many types and ways. A suitable way of irrigation 

is crucial to ensure that the crops or plants get enough of water and at the same time the 

irrigation system is benefit to the farmers where it can reduce the burden of them. It 

cannot be denied that an irrigation system has many benefits and importance. The 

importance of irrigation is increasing the availability of water supply which increase the 

income of farmer, stabilizing the output of plantation, and helping to bring most of the 

fallow land under cultivation (BYJUS, 2020). Irrigation should be optimised because ever 

over-irrigation could spoil the production of crops. Excessive water supply to the crops 

or plants would cause root diseases.   
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CHAPTER 3 

METHODOLOGY 

 

3.1 Introduction 

Methodology is a study or description of methods which includes the specific 

procedures or technique to achieve the successful of solving the problem. In this chapter 

will explained in detail of the steps or ways to develop the control system of the IoT-

based solar irrigation system. These methods are used to achieve the objectives of the 

project which to get satisfying results or outcomes on the performance of this IoT-based 

solar irrigation system. 

 

3.2 Proposed system 

In our proposed system, the control system of IoT-based solar irrigation system is 

divided into two parts which are valve control part and water monitoring part. Valve 

control part is the part which include the methods or operations of the solenoid valve to 

close or on the irrigation. Meanwhile, for the water monitoring part, this is where the 

explanation of the water flow monitoring feature. 

Figure 3.1 is the system flow diagram of the valve control part in IoT-based solar 

irrigation system. This flow diagram shows the solar energy harvesting process where the 

solar panel is used to collecting the solar energy and convert into electric energy. Next, 

the electric energy is stored into the rechargeable battery and it is a source of power to 

control the solenoid valve. Solenoid valve in this system is a controlling component to 

allow or cut down the water supply from the water tank to the irrigation of crops or plants. 

This solenoid valve is commanded by a microcontroller which is NodeMCU. Sensors are 

attached to the surrounding of the plants or crops to gain information and display to the 

user with the help of microcontroller. The microcontroller can be coding to customise the 

interface of the information provide by sensors. 
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Figure 3.1 System Flow Diagram of Valve Control 

 

Figure 3.2 below is representing for the block diagram of water monitoring part in 

the IoT-based solar irrigation system which show the connection between all the 

components such as sensor, battery, microcontroller and LCD. The microcontroller we 

used in this water monitoring part is Arduino Uno. The Arduino Uno is one of the simple 

microcontroller that can be used to work with sensor and also LCD. The battery is 

connected to Arduino Uno to operate the system and also give power supply to the LCD. 

Water flow sensor is used to gain the information of water flow through the pipe. The 

information such as water flow rate and total amount of water flow can be displayed in 

the LCD which had been connected to the Arduino Uno. The rate of water flow and total 

amount of water flow can be programmed in any unit. In this project, we programmed 

the water flow rate in litres per minute and the total amount of water flow in litres by 

using Arduino IDE. The coding is programmed in Arduino IDE and then uploaded to the 

Arduino Uno. 

 

 

Figure 3.2 Block Diagram of Water Monitoring 
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3.3 Proposed design 

In the proposed design, it will be explained in detail for the flow charts, circuits, 

components used and pseudocode.  

 

3.3.1 Valve control 

Figure 3.3 below shows the flowchart of valve control part in the IoT-based 

solar irrigation system. This flowchart is used as a guidance to the user to 

understand how the command system flow and the corresponding of the system. 

 

Figure 3.3 Flowchart of Valve Control 
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The Figure 3.4 below shows that the circuit design of valve control part in 

IoT-based solar irrigation system. The electric components such as NodeMCU, 

relay, 9V battery, 12V battery and solenoid valve are show in the figure how it 

connected in the circuit. 

 

 

Figure 3.4 Circuit Design of Valve Control 
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The microcontroller use in the valve control is NodeMCU. Figure 3.5 has 

been chosen as it can develop quickly an IoT application with less integrated 

circuits. It is an open-source firmware and development kit that plays a vital role in 

designing a proper IoT product using a few script lines. This module is mainly 

based on ESP8266 introduced by manufacturer Espressif Systems that is a low-cost 

Wi-Fi microchip incorporating both a full TCP/IP stack and microcontroller 

capability. It is complex device combining some features of the ordinary Arduino 

board and connecting to the internet. Arduino Modules and Microcontrollers have 

always been a great choice to incorporate automation into the relevant project. But 

these modules are not perfect as they do not feature a built-in WiFi capability. 

Therefore, a NodeMCU which is based on ESP8266 WiFi SoC is used to replace 

the Arduino Modules as it is a device that has some features of the Arduino board. 

This NodeMCU is also an open-source firmware and development kit that helps 

you to prototype your IoT product within a few lines of LUA script and it can be 

programmed easily using C or C++ language in Arduino IDE (A.A.Dahoud and 

M.Fezari, 2018). 

 

 

Figure 3.5 NodeMCU and Pinout function 
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Programming NodeMCU with Arduino IDE: 

1. Open Arduino IDE and navigate to File > Preferences. 

2. In the space marked “additional Boards Manager URLs” add the following url: 

http://arduino.esp8266.com/stable/package_esp8266com_index.jso 

 

 

Figure 3.6 Programming NodeMCU with Arduino IDE 

 

3. Click “OK”. 

4. Navigate to the Boards Manager. You’ll find it under Tools > Board > Boards 

Manager. 

5. Type “ESP8266” into the resulting search bar. Then install the package. 

http://arduino.esp8266.com/stable/package_esp8266com_index.jso
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Figure 3.7 Board manager for ESP8266 

 

6. Select the exact model. Go to Tools > Board and select “NodeMCU1.0 (ESP-

12E module).” 

Now ready to start uploading code to our ESP. 

 

Solenoid valve is used in this project as a controller in the valve control 

system to control the water flow to the plant. Figure 3.8 show that the 12V 

Pressurized Solenoid Valve  with a dimension of 84mm (L) x 34mm (W) x 57mm 

(H) and weight of 100g. This solenoid valve is applicable for water pressure of 

0.02-0.8Mpa. Solenoid valves are frequently used to control elements in fluidics as 

its tasks are to shut off, release, dose, distribute or mix fluids. It is found in many 

application areas because it come with the advantages of fast response time 

switching, low power consumption, cheap replacement parts and can be installed 

vertically or horizontally (Pro Water Part, 2019). The disadvantages of solenoid 

valve are sensitive to voltage and control signal must stay on during operation. 
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Figure 3.8 12V Pressurized Solenoid Valve 

 

Figure 3.9 show that the relay module that use in this project. A power relay 

module is a switch that operated by an electromagnet. The electromagnet is 

activated by a separate low-power signal from a micro controller. When activated, 

the electromagnet pulls to either open or close a circuit. A simple relay consists of 

wire coil wrapped around a soft iron core, or solenoid, an iron yoke that delivers a 

low reluctance path for magnetic flux, a movable iron armature and one or more 

sets of contacts. The movable armature is hinged to the yoke and linked to at least 

one or more set of the moving contacts. Held in place by a spring, the armature 

leaves a niche within the magnetic circuit when the relay is de-energized. While 

during this position, one among the 2 sets of contacts is closed while the opposite 

set remains open. 

When electrical current is skilled a coil, it generates a magnetic flux that 

successively activates the armature. This movement of the movable contacts makes 

or breaks a reference to the fixed contact. When the relay is de-energized, the sets 

of contacts that were closed, open and breaks the connection and vice versa if the 

contacts were open. When switching off the present to the coil, the armature is 

returned, by force, to its relaxed position. This force is typically provided by a 

spring, but gravity also can be utilized in certain applications. Most power relays 

are manufactured to work during a quick manner (GEP Power Products, 2020). 
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This relay module act as a switch to allow the electrical flow from the 12V battery 

to the solenoid valve by giving a signal from the microcontroller NodeMCU. 

 

Figure 3.9 Relay Module 

 

GP1270 12V 7.2aH Rechargeable Battery is used in this project. This Seal 

Lead Acid (SLA) Rechargeable battery is the most common general-purpose 

battery. The advantages of this battery are low cost, robust and less maintenance 

required. But it is considered heavy weight for certain robotic application. This 

SLA batteries can be charge by using any general DC power supply if it provides 

the correct voltage to the battery. It has a dimension of 15cm (L) x 6.5cm (W) x 

9cm (H) and weight of 2.32kg. The battery fully discharge is around 80 W while 

the operating time will depend on load given and power withdraw rate of the 

electronic component. Figure 3.10 show the battery that use in this project cope 

with the diaphragm water pump. The battery capacity can supply electricity to the 

motor up to 2-3 hours. The advantages of the lead–acid battery is the cheapest 

secondary power source, fully recyclable and safe equipment while the 

disadvantage is the low specific energy (Detchko Pavlov, 2017). 
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Figure 3.10 GP1270 Lead Acid Rechargeable Battery 

 

The nine-volt battery, Figure 3.11 is a rectangular prism shape with rounded 

edges and a polarized snap connector at the top. It is commonly used in walkie-

talkies, clocks and smoke detectors. The purpose of using this 9V battery is to 

supply power for the microcontroller. 

The nine-volt battery format is usually available in primary carbon-zinc and 

alkaline chemistry, in primary lithium disulfide, and in rechargeable form in nickel-

cadmium, nickel-metal hydride and lithium-ion. Mercury-oxide batteries of this 

format, once common, have not been manufactured in a few years due to their 

mercury content. Designations for this format include NEDA 1604 and IEC 6F22 

(for zinc-carbon) or MN1604 6LR61 (for alkaline).  

 

Figure 3.11 9V Battery 
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3.3.2 Water monitoring 

Figure 3.12 below shows the flowchart of water monitoring part in the IoT-

based solar irrigation system. This flowchart is used as a guidance to the user to 

understand how the command system flow and the corresponding of the system. 

 

Figure 3.12 Flowchart of Water Monitoring 
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The Figure 3.13 below shows that the circuit design of water monitoring part 

in IoT-based solar irrigation system. All the electric components such as Arduino 

Uno, YF-S201 Hall Effect Water Flow Sensor, and 2x16 LCD with I2C are show 

in the figure how it connected in the circuit. 

 

 

Figure 3.13 Circuit Design of Water Monitoring 

 

Arduino Uno is the microcontroller that use in the water monitoring system. 

Figure 3.14 is an open-source microcontroller board based on the Microchip 

ATmega328P. This board is equipped with sets of digital and analog input/output 

(I/O) pins which can interface to various expansion boards and other circuits. It has 

12 digital I/O pins (6 capable of PMW output), 6 analog I/O pins, and can be 

programmable easily using C or C++ language with Arduino IDE (Integrated 

Development Environment) by connecting with type B USB cable. This 

microcontroller can be powered by 9V battery or the USB cable. In this project, 

Arduino Uno 
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this Arduino Uno use to receive the signal from water flow sensor and displaying 

the water flow rate in the LCD. 

 

 

Figure 3.14 Arduino Uno 

 

Programming Arduino Uno with Arduino IDE: 

1. Download the ZIP library file from the link below: 

https://github.com/fdebrabander/Arduino-LiquidCrystal-I2C-library 

2. Open Arduino IDE > Sketch > Include Library > Add .ZIP Library… 

3. Find your downloaded ZIP file in step 1 > Select on the file > Open 

Now it is ready to start the programming. 

In the Arduino IDE, you must include the library file in the coding as Figure 

3.15 in order to use the LCD. The LCD would not success to display if the library 

file is not including. 

 

 

Figure 3.15 Including LCD library 

 

https://github.com/fdebrabander/Arduino-LiquidCrystal-I2C-library
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In this project, the water flow sensor that use is YS-S201 Hall Effect Water 

Flow Sensor as in Figure 3.16. The water flow sensor is installed at the water source 

or pipes to measure the speed of flow of water and calculate the quantity of water 

flowed through the pipe. Rate of flow of water is measured as litres per hour or 

cubic meters. Water flow sensor consists of a plastic valve from which water can 

pass. A water rotor along with a hall effect sensor is present the sense and measure 

the water flow. When water flows through the valve it rotates the rotor. By this, the 

change is often observed within the speed of the motor. this alteration is calculated 

as output as a pulse signal by the hall effect sensor. Thus, the speed of flow of water 

are often measured (ElProCus, 2019). 

The main working rule behind the working of this sensor is that the hall effect. 

consistent with this principle, during this sensor, a voltage difference is induced 

within the conductor due to the rotation of the rotor. This induced voltage difference 

is transverse to the electrical current. The water flow sensor is often used with hot 

waters, cold waters, warm waters, clean water, and dirty water also. These sensors 

are available in several diameters, with different flow ranges. 

 

Figure 3.16 YF-S201 Hall Effect Sensor Water Flow Sensor 
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In the water flow monitoring system, LCD is used to display the value of 

flow rate (L) per minutes (min). LCD (Liquid Crystal Display) screen is an 

electronic display module. The LCD used in this project is a 16x2 LCD display and 

it is very commonly used in various devices and circuits. This LCD can display 16 

characters per line and there are 2 such lines. In this LCD each character is 

displayed in 5x7 pixel matrix. The 16x2 intelligent alphanumeric dot matrix display 

can display 224 different characters and symbols. This LCD has two registers, 

namely, Command and Data (Instructables, 2020). Figure 3.17 show that the LCD 

is connecting with a I2C (Inter-Integrated Circuit). The purpose of using I2C is to 

make the connection easier as the LCD pins from 16 is reduced to 4.  

 

 

Figure 3.17 2x16 LCD with I2C 

 

 

3.4 Summary 

In the control system of IoT-based solar irrigation system, the exist of valve control 

part and water monitoring part is very crucial in this system to allow the user controlling 

the irrigation and at the same time user can monitor the information of the water flow. 

The information of water flow is important as it can be used to supervise the usage of 

water in the irrigation system. 
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CHAPTER 4 

RESULTS AND DISCUSSION 

 

4.1 Introduction 

In this chapter, the results and outcomes of the project will be listed and showed in 

detail. The information and actual design of the system is showed by figure in below. 

 

4.2 Developed water control system 

The drip system of irrigation was setup in the rabbit site of FTKEE. This setup is 

to mock the same irrigation system that use by YPPH Sdn. Bhd. in their pre-nursery. The 

way of irrigation is using 16mm of driptape (Figure 4.1) which contain holes on the wall 

of the tape. The water droplet will drop out from the driptape through these holes. The 

driptape are placed on the top of Parit Tray (Figure 4.2). Parit Tray has drain along the 

tray which will be filled with medium or soil. This drain is used to collect the water 

droplet that supply by the driptape and then later absorb by the medium which placed 

along the side of the drain. Parit Tray is placed above ground with a 63cm of height to 

avoid disease infection and pest. 

 

 

Figure 4.1 16mm Driptape 
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Figure 4.2 Parit Tray 

 

Meanwhile, for the water supply, we also using the same concept as YPPH Sdn. 

Bhd. idea that used in their pre-nursery. A water tank is placed above the ground with 3 

metres. The purpose of placing the water tank higher from the ground is to produce a 

gravity force which may create water pressure. As a result, this water tank able to provide 

a 4psi or 0.28bar of water pressure. Hence, this low pressure of water pressure is suitable 

to use for the driptape which has a thin layer of wall that cannot withstand high pressure 

of water. 

 

 

Figure 4.3 Water Tank in Rabbit Site 

63cm 

3m 
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The valve control system and water monitoring system are constructed before water 

distribution of driptape. Figure 4.4 show that the combination of valve control and water 

monitoring system at the water entering part before the distribution of driptape. Figure 

4.5 show the driptape is built with 12 metres long start from the water entering part to the 

end of irrigation area. 

 

 

Figure 4.4 Water Entering Part 

 

 

Figure 4.5 12m of Driptape 

12m 
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4.3 Developed design 

The developed design is divided into two parts which are valve control and water 

monitoring. The actual design of the circuit will be showed in figure below. 

 

4.3.1 Actual valve control 

The solenoid valve is installed with 20cm PVC pipe in middle of the water 

entering part as Figure 4.4 which is in between of the distribution of driptape and 

the water monitoring part. The solenoid valve is powered by the solar water pump 

as Figure 4.7. The solar water pump is placed beside the Parit Tray because of the 

sensors have to place nearby the plants or crops to get the real surrounding 

information. 

 

 

Figure 4.6 Solenoid Valve 
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Figure 4.7 Solar Water Pump 

 

In this project, the solenoid valve is controlled by the mobile application 

“Blynk”. This application is applicable to use in iOS or Android operating system 

and it can be downloaded through App Store or Google Play Store. Blynk is an 

application which could be synchronized with the server. During the 

synchronization process, the targeted server address is required, followed by the 

host port, the username and the specified authentication token given by the server 

as in Figure 4.8. 

 

Figure 4.8 Authentication token in Blynk 

 

Figure 4.9 shows the mobile data and hotspot identification for the open 

networks to generate the system in the Blynk application. The username and 

password identification can be customized by users through their smartphone and 

both of these are belonging to the users to operate the system using Blynk 

application. 

 

Figure 4.9 Username and password mobile hotspot 
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Figure 4.10 show that the programmed coding in Arduino IDE to command 

the solenoid valve to ON or OFF. The coding pinMode(D1,OUTPUT) is to 

configure pin D1 to behave as an output. And this output is connected to relay 

which use to control the electric flow from battery to solenoid valve. 

 

 

Figure 4.10 Valve control coding 

 

4.3.2 Actual water monitoring 

Water monitoring is the part where involving the use of water pressure gauge, 

water flow sensor, Arduino Uno and LCD as in Figure 4.11. The water pressure 

gauge and water flow sensor are installed with the 20cm PVC pipe to get the 

information of water pressure and flow rate. The water pressure can be gained when 

the piping system in close or non-leakage condition. Meanwhile, the flow rate can 

be achieved when there is water flow through the sensor.  

 

 

Figure 4.11 Water Monitoring 
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As an outcome for the project, we had taken the results of the water 

monitoring before and after the solenoid valve is ON. The Figure 4.12 and Figure 

4.13 show the different of water pressure gauge and LCD. Before the solenoid valve 

is ON, the water pressure gauge show that the water pressure is 4psi or 0.28bar and 

the LCD do not have any increasement of values. After the solenoid valve is ON, 

the water pressure gauge drops to 0 and the LCD value is keep increasing according 

to the time.  

 

 

Figure 4.12 Before solenoid valve is ON 

 

 

Figure 4.13 After solenoid valve is ON 
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The time taken to flow along the driptape and irrigate until the water is 

overflow from the medium of Parit Tray was tested in two conditions which are in 

empty and residue water. Both conditions are tested under the same condition of 

water pressure which is 4psi or 0.28bar. When the condition of driptape is in empty, 

the time taken for water overflow is 9 minutes and 54 seconds while when the 

driptape is in residue water condition, the time taken for water overflow is 7 minutes 

and 21 seconds. 

 

Table 4.1 Results of Irrigation 

Condition of Driptape Time Taken for Water Overflow 

Empty 9min 54s 

Residue Water 7min 21s 

 

4.4 Summary 

In summary, the results show that there is different between the before and after the 

solenoid valve is ON. This result means that the information of water pressure is vital to 

let the user or farmer alert with the condition of water pressure. If the water pressure is 

low than normal condition although the solenoid is OFF, this may cause by some factors. 

The factors of this condition are the water level in the water tank is low, water leakage 

happening and faulty of solenoid valve. For the results of irrigation, it shows that the time 

taken for water overflow is different corresponding to the condition of driptape. This 

means the farmer required higher time for irrigation to achieve enough water for the 

plants or crops if he or she had performed flushing on the driptape in order to clean up 

the blockage in the piping system. But, for the next irrigation, the time taken is much 

lesser which is only 7 minutes and 21 seconds. 
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CHAPTER 5 

CONCLUSION AND RECOMMENDATION 

 

5.1 Introduction 

In the conclusion part, the overall project will be summarized, the 

recommendations of the project will be stated, and future work is suggested to give an 

idea to other researcher who refer to this thesis. 

 

5.2 Conclusion 

In conclusion, the objectives of this project are achieved. This project successfully 

to develop an IoT-based solar irrigation system which can be operated by solar energy. 

The solenoid valve of this system can be controlled and monitored by the microcontroller 

through mobile application. The mobile application Blynk can be downloaded from the 

store in iOS or Android system smartphones. The usages of water and electricity can be 

optimized by using this system. With the help of this system, farmers able to monitor and 

control their irrigation using technology and make their works more systematic.  

Furthermore, this system is using a low-cost material with RM468.70 which make it 

affordable by many small scales of farmers. Our developed product can be defined as an 

environment-friendly product as it is powered by solar energy. Using the renewable 

resources has be a trend nowadays as the pollutions in our world keep increasing and lead 

to many climates change. Solar powered product not only environment-friendly but also 

reduce the cost of using electricity.  
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5.3 Recommendation 

This system may not define as a perfect project as it has some improvement can be 

done to increase the performance, safety, and functionality. In this project, there is some 

limitations found during the testing phase. The limitation is the microcontrollers use in 

this project is more than one. This way of designing may increase the complexity of 

system and the cost of product. In recommendation, the complexity of this system can be 

solved by using a microcontroller that has more pin and able to handle large amount of 

tasking.  

Besides, this system also not a fully automated system that able to stop the irrigation 

when the soil moisture is achieved the appropriate amount of value. This problem can be 

solved by further study in the programming part of the microcontroller. Furthermore, this 

limitation of this system is only can be commanded to on or off the solenoid valve. This 

controlling system can be improved to let the user able to choose duration of the valve on 

by adding a real-time clock (RTC) module to the microcontroller. Real-time clock 

module provides the system with a time that allow the microcontroller to be improved in 

any features that has relationship with time. 

 

5.4 Future work 

In future, this IoT-based solar irrigation system may be improved to be a system 

that not only using solar to operate. There are many other renewable resources can be 

used to power this system such as hydropower, wind energy and biomass energy. A good 

system should not only depend on using solar energy as the weather of each day may 

different. Cloudy day and raining season will decrease the performance of solar panel. 

Therefore, other renewable resources can be used to replace the solar energy. 
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APPENDICES 

A COSTING 

Table A1 List of Items with Price 

No. Items Unit Price Quantity Amount 

1 NodeMCU Board with Baseboard RM24.80 2 RM24.80 

2 3/4" PVC Pipe RM9.00 1 RM9.00 

3 3/4" PVC Pipe Fittings RM4.80 1 RM4.80 

4 16mm Drip Tape Fittings RM22.00 1 RM22.00 

5 16mm Drip Tape (50m) RM30.00 1 RM30.00 

6 PVC Socket Reducer 3/4" x 1/2" RM0.45 1 RM0.45 

7 LCD Module 16x2 RM20.30 1 RM20.30 

8 Rain Sensor RM7.00 1 RM7.00 

9 Soil Moisture Sensor RM7.00 1 RM7.00 

10 40P Jumper Wires 20cm RM4.00 3 RM12.00 

11 12V DC Solenoid Valve RM28.00 1 RM28.00 

12 Water Flow Sensor RM23.00 1 RM23.00 

13 9V Battery Holder and Connector RM3.00 1 RM3.00 

14 1/2" PVC Pipe Fittings RM5.35 1 RM5.35 

15 1/2" PVC Pipe (1m) RM1.60 1 RM1.60 

16 Orange PVC Hose (5m) RM13.00 1 RM13.00 

17 2" 4bar Water Pressure Gauge RM25.00 1 RM25.00 

18 1/4" x 3/8" Bush RM3.50 1 RM3.50 

19 3/8" x 1/2" Bush RM4.00 1 RM4.00 

20 

2 Core PVC Twin Flat Cable 23/0.14x2C 

(per m) 
RM1.00 18 RM18.00 

21 

Raspberry Pi 3 Model B+ with Micro SD 

Card 
RM192.00 1 RM192.00 

22 Arduino UNO RM14.90 1 RM14.90 

  Total RM468.70 
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B GANTT CHART 

B1. GANTT CHART I 

 

 

 

B2. GANTT CHART II 
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C Programming Coding 

 

C1. Water monitoring (Arduino) 

volatile int flow_frequency; // Measures flow sensor pulses 

// Calculated litres/hour 

float vol = 0.0,l_minute; 

unsigned char flowsensor = 2; // Sensor Input 

unsigned long currentTime; 

unsigned long cloopTime; 

#include <Wire.h>  

#include <LiquidCrystal_I2C.h> 

LiquidCrystal_I2C lcd(0x27, 16, 2); 

 

void flow () // Interrupt function 

{ 

   flow_frequency++; 

} 

void setup() 

{ 

   pinMode(flowsensor, INPUT); 

   digitalWrite(flowsensor, HIGH); // Optional Internal Pull-

Up 

   Serial.begin(9600); 

   lcd.begin(); 

   attachInterrupt(digitalPinToInterrupt(flowsensor), flow, 

RISING); // Setup Interrupt 

   lcd.clear(); 

   lcd.setCursor(6,0); 

   lcd.print("ISIRS"); 

   lcd.setCursor(0,1); 

   lcd.print("Water Flow Meter"); 

   currentTime = millis(); 

   cloopTime = currentTime; 

} 

 

void loop () 

{ 

   currentTime = millis(); 

   // Every second, calculate and print litres/hour 

   if(currentTime >= (cloopTime + 1000)) 

   { 

    cloopTime = currentTime; // Updates cloopTime 

    if(flow_frequency != 0){ 

      // Pulse frequency (Hz) = 7.5Q, Q is flow rate in L/min. 

      l_minute = (flow_frequency / 7.5); // (Pulse frequency x 

60 min) / 7.5Q = flowrate in L/hour 
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      lcd.clear(); 

      lcd.setCursor(0,0); 

      lcd.print("Rate: "); 

      lcd.print(l_minute); 

      lcd.print(" L/M"); 

      l_minute = l_minute/60; 

      lcd.setCursor(0,1); 

      vol = vol +l_minute; 

      lcd.print("Vol :"); 

      lcd.print(vol); 

      lcd.print(" L"); 

      flow_frequency = 0; // Reset Counter 

      Serial.print(l_minute, DEC); // Print litres/hour 

      Serial.println(" L/Sec"); 

    } 

    else { 

      Serial.println(" flow rate = 0 "); 

      lcd.clear(); 

      lcd.setCursor(0,0); 

      lcd.print("Rate: "); 

      lcd.print( flow_frequency ); 

      lcd.print(" L/M"); 

      lcd.setCursor(0,1); 

      lcd.print("Vol :"); 

      lcd.print(vol); 

      lcd.print(" L"); 

    } 

   } 

} 

void countPulse() 

{ 

  count++; 

} 
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C2. Valve controlling (NodeMCU) 

#define BLYNK_PRINT Serial 

#include <ESP8266WiFi.h> 

#include <BlynkSimpleEsp8266.h> 

#include <DHT.h> 

  

// You should get Auth Token in the Blynk App. 

// Go to the Project Settings (nut icon). 

char auth[] = "FqL29ghfSfstbk0lle79NGsvTcn7-CQh"; 

 

// Your WiFi credentials. 

// Set password to "" for open networks. 

char ssid[] = "Aiman's Iphone"; 

char pass[] = "aiman123"; 

 

int sensorState = 0; 

int lastState = 0; 

int sensorPin = A0;   

int sensorValue = 0;   

int percent = 0; 

#define DHTPIN 0  // D3 

// Uncomment whatever type you're using! 

#define DHTTYPE DHT11     // DHT 11 

//#define DHTTYPE DHT22   // DHT 22, AM2302, AM2321 

//#define DHTTYPE DHT21   // DHT 21, AM2301 

DHT dht(DHTPIN, DHTTYPE); 

BlynkTimer timer; 

  

// This function sends Arduino's up time every second to 

Virtual Pin (5). 

// In the app, Widget's reading frequency should be set to 

PUSH. This means 

// that you define how often to send data to Blynk App. 

void sendSensor() 

{ 

  float h = dht.readHumidity(); 

  float t = dht.readTemperature(); // or 

dht.readTemperature(true) for Fahrenheit 

  

  if (isnan(h) || isnan(t)) { 

    Serial.println("Failed to read from DHT sensor!"); 

    return; 

  } 

  // You can send any value at any time. 

  // Please don't send more that 10 values per second. 

  Blynk.virtualWrite(V5, t); 

  Blynk.virtualWrite(V6, h); 

}  
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void setup() 

{ 

  // Debug console 

  Serial.begin(9600); 

  

  Blynk.begin(auth, ssid, pass); 

  // You can also specify server: 

  //Blynk.begin(auth, ssid, pass, "blynk-cloud.com", 8442); 

  //Blynk.begin(auth, ssid, pass, IPAddress(192,168,1,100), 

8442); 

  pinMode(sensorPin, INPUT); 

  dht.begin(); 

  pinMode(D1,OUTPUT); 

  digitalWrite(D1,HIGH); 

   

  // Setup a function to be called every second 

  timer.setInterval(1000L, sendSensor); 

} 

void loop() 

{ 

  Blynk.run(); 

  timer.run(); 

   

  sensorValue = analogRead(sensorPin); 

  percent = convertToPercent(sensorValue); 

  printValuesToSerial(); 

  delay(1000); 

  } 

int convertToPercent(int value) 

{ 

  int percentValue = 0; 

  percentValue = map(value, 1023, 465, 0, 100); 

  return percentValue; 

} 

void printValuesToSerial() 

{ 

  Serial.print("\n\nAnalog Value: "); 

  Serial.print(sensorValue); 

  Serial.print("\nPercent: "); 

  Serial.print(percent); 

  Serial.print("%"); 

  Blynk.virtualWrite(V4, percent); 

} 
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D SITE VISIT PHOTO 

 

 

Figure D1 Site Visit to Merchong Nursery 

 

 

 

 

Figure D2 Sprinkler Irrigation 

 

Figure D3 Hyplug Tray 

 

 

 

 

 

Figure D4 Diesel Water 
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Figure D5 Site Visit to Endau-Rompin Nursery 

 

 

 

 

 

Figure D6 Drip Irrigation 

 

 

 

 

 

 

 

 

 

 

 

Figure D7 Discussion on Lake 

 

 

 

 

 

Figure D8 Water Tank in Pre-Nursery 

 


